Kepler - Issues

# Tracker Status Priority Subject Assignee Updated

2460 Bug Resolved Normal Zip Files actor does not appear in actor list Dan Higgins 06/15/2006 02:10 PM
4090 Bug Resolved Normal You should be able to specify a particular revision number or date with ant update. David Welker 06/12/2009 01:28 PM
3970 Bug Resolved Normal XSLT unnecessarily writes to a file Chad Berkley 04/27/2009 07:02 PM
3968 Bug Resolved Normal XSLTActor temporary file bug Chad Berkley 04/27/2009 07:01 PM
4025 Bug Resolved Normal XSLTActor accepts StringToken as input Chad Berkley 04/27/2009 07:03 PM
4000 Bug Resolved Normal WRP - upload PRAs to repository Michael Daigle 06/25/2009 03:38 PM
4200 Bug Resolved Normal wrp suite - blank workflow says you've made changes upon exit Chad Berkley 06/30/2009 09:25 AM
4001 Bug Resolved Normal WRP - Save/Open KARs containing MOMLs and ROMLs ben leinfelder 06/25/2009 03:42 PM
4467 Bug Resolved Normal WRP - restarting/reopening Kepler throws error debi staggs 12/24/2009 01:27 PM
4177 Bug Resolved Normal WRP - look up Parameter values from Provenance ben leinfelder 06/19/2009 09:27 PM
4893 Bug Resolved Normal WRP Kepler Frame vertically fills entire screen Derik Barseghian 04/26/2010 03:37 PM
4020 Bug Resolved Normal WRP - create WorkflowRun object to encapsulate provenance/report instances Derik Barseghian 06/25/2009 04:40 PM
3999 Bug Resolved Normal WRP - create event-driven states for Kepler ben leinfelder 06/19/2009 12:18 PM
2726 Bug Resolved Normal Wrong R working directory in specialized R actors Dan Higgins 01/17/2007 04:05 PM
5782 Bug Resolved Normal wrong behavior when trying to Export a run when module dependencies not satisfied Derik Barseghian 01/15/2013 01:40 PM
5407 Bug Resolved Normal wrm/tagging have errors when starting with provenance turned off Derik Barseghian 06/22/2011 01:42 PM
4181 Bug Resolved Normal WRM - provenance sql.properties "DB Name" ignored Derik Barseghian 06/23/2009 01:44 PM
4721 Bug Resolved Normal wrm gets exception when provenance turned off Daniel Crawl 02/12/2010 11:42 AM
4192 Bug Resolved Normal WRM - do not prompt for KAR file when uploading to repository Chad Berkley 06/26/2009 04:51 PM
4363 Bug New Normal wrm does not properly handle ModelReference actor Derik Barseghian 09/03/2009 02:12 PM
4037 Bug Resolved Normal WRM - connect to Kepler-wide configurable provenance store Derik Barseghian 11/23/2009 03:38 PM
4036 Bug Resolved Normal WRM - connect to configurable provenance store Derik Barseghian 06/19/2009 05:57 PM
4972 Bug Resolved Normal Write documentation for workflow-run-manager module Derik Barseghian 05/26/2010 01:35 PM
4971 Bug Resolved Normal Write documentation for tagging module Sean Riddle 05/25/2010 12:49 PM
4647 Bug Resolved Normal Write documentation for Reporting in the style of Kepler Docs debi staggs 06/07/2010 12:16 PM
4254 Bug New Normal wrapping up, never ending workflow! (PN inside PN) Christopher Brooks 07/20/2009 05:51 PM
1903 Bug Resolved Normal Wrappers to access ADN metadata Efrat Jaeger 10/17/2005 11:09 AM
4233 Bug Resolved Normal Workflow View - Need to change old instructions on how to generate a report. debi staggs 07/26/2009 04:30 AM
4672 Bug Resolved Normal Workflow title isn't refreshed during run export workflow rename Derik Barseghian 04/15/2010 02:51 PM
4937 Bug Resolved Normal Workflow tags showing as deletable in Tagging when clicking on Run Sean Riddle 04/13/2010 12:32 PM
5552 Bug Resolved Normal Workflow Scheduler GUI needs a licenses.txt file Jing Tao 12/21/2011 02:26 PM
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3127 Bug Resolved Normal workflows can open off the screen Chad Berkley 03/06/2008 02:39 PM
4619 Bug Resolved Normal WorkflowRuns not showing inside KARs in library Derik Barseghian 03/31/2010 05:59 PM
4251 Bug Resolved Normal Workflow Run Manager - wrong rows when operating on re-sorted table Derik Barseghian 07/31/2009 04:27 PM
4606 Bug Resolved Normal Workflow Run Manager - using CAPS in tags search doesn't work Derik Barseghian 12/07/2009 04:11 PM
4148 Bug Resolved Normal Workflow Run Manager - Upload to Repository feature Derik Barseghian 06/26/2009 10:29 AM
5671 Bug New Normal Workflow Run Manager tries to connect to keplerDevRepository as a database instead of kar store Derik Barseghian 08/10/2012 01:18 PM
4589 Bug New Normal Workflow Run Manager - tagging causes row(s) to unhighlight Derik Barseghian 01/13/2010 02:22 PM
4674 Bug New Normal WorkflowRunManager search cells are catching tab keys wherever they occur Derik Barseghian 01/14/2010 06:02 PM
4138 Bug New Normal Workflow Run Manager - search cell edit focus isn't lost appropriately Derik Barseghian 08/31/2009 05:07 PM
4137 Bug New Normal Workflow Run Manager - resizing width of column while in edit mode of search cell does not resize edit | Derik Barseghian 08/31/2009 05:06 PM

field

4308 Bug Resolved Normal Workflow Run Manager - problem with getWorkflowRunsForExecutions in mysq|l Daniel Crawl 09/18/2009 07:17 PM
4132 Bug New Normal Workflow Run Manager - Open in New Window is just opening the workflow, not the ROML or report Derik Barseghian 11/13/2009 07:23 PM
4131 Bug New Normal Workflow Run Manager - Open in New Window allows opening same wf multiple times Derik Barseghian 08/31/2009 05:06 PM
4607 Bug Resolved Normal Workflow Run Manager - opening kar no longer adds run-row Derik Barseghian 12/14/2009 05:32 PM
5297 Bug Resolved Normal Workflow Run Manager - no indication of progress during preview runs download Derik Barseghian 02/08/2011 04:20 PM
4518 Bug Resolved Normal Workflow Run Manager - no imported run tags Derik Barseghian 01/13/2010 02:47 PM
5296 Bug Resolved Normal Workflow Run Manager - multiple window, remote store gui refresh issue Derik Barseghian 02/14/2011 05:56 PM
4144 Bug Resolved Normal Workflow Run Manager - moving columns / new windows bug Derik Barseghian 06/15/2009 11:37 AM
5329 Bug New Normal Workflow Run Manager - launch Provenance Browser from run-row Derik Barseghian 02/28/2011 06:50 PM
4456 Bug Resolved Normal Workflow Run Manager in Report Viewer Derik Barseghian 02/12/2010 11:49 AM
5330 Bug New Normal Workflow Run Manager - include provenance trace file in run-kar Derik Barseghian 07/14/2011 12:28 PM
4566 Bug Resolved Normal Workflow Run Manager - highlighting sometimes doesn't work for multiple rows Derik Barseghian 11/20/2009 02:56 PM
4231 Bug Resolved Normal Workflow Run Manager - failed runs should be highlighted red Derik Barseghian 04/19/2010 05:38 PM
4149 Bug Resolved Normal Workflow Run Manager - Export Runs feature Derik Barseghian 06/25/2009 01:19 PM
4552 Bug Resolved Normal Workflow Run Manager Export Archive no longer adding to Library Derik Barseghian 11/16/2009 03:13 PM
4590 Bug Resolved Normal Workflow Run Manager - Export Archive can give error Aaron Aaron 12/14/2009 05:32 PM
5591 Bug New Normal Workflow Run Manager error downloading run for which module dependencies not satisfied Derik Barseghian 04/28/2012 10:45 AM
4313 Bug Resolved Normal Workflow Run Manager - duplicate rows shown for same execution Derik Barseghian 08/13/2009 02:03 PM
4134 Bug Resolved Normal Workflow Run Manager - double clicking on search cell shouldn't sort column Derik Barseghian 08/07/2009 06:24 PM
4357 Bug Resolved Normal Workflow Run Manager does not mark last failed execution red Derik Barseghian 04/19/2010 05:40 PM
4694 Bug Resolved Normal workflow run manager - differentiate imported runs Derik Barseghian 01/03/2011 12:03 PM
4252 Bug Resolved Normal Workflow Run Manager - deleting a run before running a wf doesn't work Derik Barseghian 07/16/2009 11:12 AM
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4140 Bug Resolved Normal Workflow Run Manager - delete runs functionality needs to be written Derik Barseghian 08/20/2009 05:11 PM
4325 Bug Resolved Normal Workflow Run Manager - deleted runs sometimes reappear after Kepler relaunch Derik Barseghian 11/30/2009 05:49 PM
4135 Bug Resolved Normal Workflow Run Manager - default sorting (by date) should be applied Derik Barseghian 08/07/2009 03:48 PM
4136 Bug Resolved Normal Workflow Run Manager - date and duration search should allow single operator-less arguments Derik Barseghian 02/04/2011 03:19 PM
4361 Bug New Normal Workflow Run Manager column "Workflow Name" can be confusing Derik Barseghian 04/26/2010 03:43 PM
4133 Bug Resolved Normal Workflow Run Manager - column widths should be size appropriately Derik Barseghian 07/08/2009 06:02 PM
4793 Bug Resolved Normal Workflow Run Manager - clicking on row when provenance is off gives error Derik Barseghian 04/02/2010 12:29 PM
5697 Bug New Normal Workflow Run Manager can fail to Force Open a run kar that Kepler can Derik Barseghian 11/30/2012 02:06 PM
5033 Bug Resolved Normal Workflow Run Manager - Allow multiple instances of WRM in one Kepler instance Derik Barseghian 02/14/2011 01:45 PM
4434 Bug New Normal Workflow Run Manager - add ability to hide/show columns Derik Barseghian 01/13/2010 02:19 PM
4327 Bug New Normal Workflow Run Manager - ability to import run archives Derik Barseghian 04/26/2010 03:45 PM
4454 Bug Resolved Normal Workflow Run Manager - ability to display new run tags Derik Barseghian 11/30/2009 04:19 PM
5032 Bug Resolved Normal Workflow Run Manager - ability to connect to different prov stores from gui actions Derik Barseghian 02/14/2011 01:45 PM
4898 Bug Resolved Normal WorkflowRun entityld Isid no longer incrementing after getting tagged Derik Barseghian 03/31/2010 04:58 PM
5200 Bug Resolved Normal WorkflowRun and Reporting artifacts no longer put into run-kars Derik Barseghian 11/03/2010 04:29 PM
4679 Bug Resolved Normal Workflow Name in Workflow Run Manager is not updated when renaming workflow Daniel Crawl 01/19/2010 04:45 PM
5426 Bug Resolved Normal workflow Isid changes when running from command line Daniel Crawl 08/17/2012 06:49 PM
4786 Bug Resolved Normal workflow file saved in KAR does not open when extracted Aaron Aaron 02/16/2010 02:18 PM
3264 Bug Resolved Normal workflow ENM/ASC2RAWTest gives an exception under ubuntu Chad Berkley 05/07/2008 04:19 PM
4285 Bug New Normal workflow canvas does not repack to fill empty space when top window is resized Timothy McPhillips 01/13/2010 03:57 PM
3466 Bug Works For Me Normal workflow can fail to load when using ParameterSet Chad Berkley 12/23/2015 02:16 PM
5401 Bug New Normal Workflow archiving dataturbine data to metacat should check the last archiving time through repository | Derik Barseghian 05/12/2011 02:14 PM
3172 Bug New Normal windows mouse wheel doesn't scroll canvas Derik Barseghian 02/09/2010 04:19 PM
2506 Bug Resolved Normal Windows installer w/o jvm complains about invalid jvm Dan Higgins 04/06/2007 03:45 PM
5507 Bug Resolved Normal Windows Installer: The R choice is not unselectable Derik Barseghian 11/08/2011 06:46 PM
5550 Bug Resolved Normal Windows installer should be a .exe, not a .jar Christopher Brooks 06/26/2012 10:57 AM
5506 Bug Resolved Normal Windows Installer Page does not mention 2.3? Derik Barseghian 11/21/2011 07:29 PM
3250 Bug Resolved Normal windows exe opens dos box Chad Berkley 05/02/2008 11:20 AM
3539 Bug New Normal wierd behaviors of port parameter Chad Berkley 04/03/2009 02:46 PM
3219 Bug Resolved Normal White space in installation path fails on config file read Aaron Aaron 04/11/2008 02:12 PM
4187 Bug Resolved Normal When running with reporting suite, a blank canvas is considered changed and unsaved debi staggs 08/06/2009 08:24 AM
5189 Bug New Normal When File -> Exit is choosen Kepler closes all workflows without warning Chad Berkley 09/22/2010 08:56 AM
4896 Bug Resolved Normal When exporting multiple runs only 1 ROML is placed in KAR debi staggs 05/14/2010 02:24 PM
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4402 Bug Resolved Normal When a report item is deleted clear the properties window debi staggs 12/07/2009 10:30 AM
5181 Bug Resolved Normal welcome window shows wrong version number Derik Barseghian 09/29/2010 01:13 PM
2351 Bug Resolved Normal Welcome Window Programmer/Scientist docs llkay Altintas 03/22/2006 04:12 PM
3283 Bug Resolved Normal Welcome splash screen shows up when starting windows kepler Chad Berkley 05/08/2008 09:02 AM
2232 Bug Resolved Normal Website updates llkay Altintas 03/22/2006 04:11 PM
5651 Bug Resolved Normal WebService, WebServiceStub and MessageBasedWebService have duplicate code Daniel Crawl 09/18/2012 11:41 AM
4062 Bug Resolved Normal Web Services and Data Transformation demo throws a StringOutOfBounds Daniel Crawl 05/20/2009 09:06 AM
2378 Bug Resolved Normal WebService not Responding Daniel Crawl 12/13/2007 03:48 PM
4118 Bug Resolved Normal Web Service Actor stored in Library Daniel Crawl 07/14/2010 10:20 AM
3899 Bug New Normal web service actor does not work through proxy Chad Berkley 04/03/2009 03:18 PM
2921 Bug New Normal Way to temporarily comment out actors or connections Christopher Brooks 04/03/2009 02:18 PM
4197 Bug Resolved Normal Waterflow TPC demo - tracking bug ben leinfelder 11/18/2009 10:47 AM
2829 Bug Resolved Normal "Warning: Unrecognized XML Element" message Dan Higgins 04/20/2007 02:56 PM
3091 Bug Resolved Normal Warnings building org.nddp.DataTypes Timothy McPhillips 01/23/2008 04:51 PM
5446 Bug Resolved Normal View=>XML View broken David Welker 08/02/2011 04:25 PM
4595 Bug Resolved Normal ViewPane selection does not work with toolbar tear-off Chad Berkley 02/03/2010 11:48 AM
4438 Bug Resolved Normal View: label shouldn't appear when there's no view drop-down menu Derik Barseghian 01/14/2010 04:37 PM
4569 Bug Resolved Normal viewing report before executing sometimes generates persistent blank report ben leinfelder 12/14/2009 01:22 PM
4409 Bug Resolved Normal View Documentation for an actor works once Aaron Aaron 12/02/2009 12:23 PM
5442 Bug Resolved Normal View->Automate Layout doesn't work in kepler-2.3 branch David Welker 09/26/2011 05:34 PM
1999 Bug Resolved Normal Very long delays on first startup of new install Chad Berkley 05/16/2005 09:01 AM
4797 Bug Resolved Normal Verify that multiple workflow/actor KARs work as expected Aaron Aaron 03/03/2010 04:21 PM
4358 Bug New Normal variable setter seems to lock Kepler in the wrapping up stage of a workflow Chad Berkley 01/13/2010 02:33 PM
5692 Bug New Normal Values not committed to actors Derik Barseghian 08/27/2012 06:18 PM
3282 Bug Resolved Normal v3 installer intro says Kepler-1.0.0 1.0.0 Chad Berkley 05/09/2008 11:33 AM
2510 Bug Resolved Normal Using the parameter for file input in the IJMacro actor does not work Dan Higgins 04/09/2007 03:10 PM
4162 Bug New Normal using the alt key makes menus appear in strange places on OSX Chad Berkley 08/26/2009 02:55 PM
5251 Bug Resolved Normal using File->Open MoML... always opens model into Sensor Site view Sean Riddle 02/14/2011 01:45 PM
4781 Bug Resolved Normal Use the KarXmlGenerator to create the xml metadata sent to the metacat server during "Upload To Aaron Aaron 02/09/2010 03:34 PM

Repository" action

5593 Bug New Normal use setDefaultWidth in actors Derik Barseghian 04/28/2012 03:05 PM
5027 Bug New Normal Users should be able to build installers for the Kepler-2.0 branch Chad Berkley 05/24/2010 02:22 PM
5226 Bug Resolved Normal User should be warned to design a report if there isn't a report when scheduling Jing Tao 02/14/2011 01:45 PM
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5571 Bug Resolved Normal user request: show execution time in runtime window Christopher Brooks 06/15/2012 02:23 PM
5714 Bug Resolved Normal user manual documentation for 2.4. jianwu jianwu 11/14/2012 05:29 PM
4984 Bug Resolved Normal user mailing list is wrong Chad Berkley 05/20/2010 04:44 AM
4829 Bug New Normal User log4j files Derik Barseghian 02/23/2010 06:22 PM
4057 Bug New Normal UserlnteractiveShell message Chad Berkley 08/12/2009 03:32 PM
1845 Bug Resolved Normal user input for port type should not be case sensitive Matthew Brooke 12/20/2005 11:09 AM
4168 Bug New Normal User documentation creates bloat in workflows Chad Berkley 07/13/2009 04:09 PM
5400 Bug New Normal User can specify the interval of data chunk in the workflow archiving dataturbine data to metacat Derik Barseghian 04/26/2012 02:01 PM
4203 Bug In Progress Normal use port parameters in web service actors Daniel Crawl 08/26/2009 03:56 PM
5594 Bug New Normal use input and output port icons in ltems of Interest Derik Barseghian 04/28/2012 04:29 PM
5502 Bug Resolved Normal use https to svn check out modules Derik Barseghian 12/05/2011 06:23 PM
5447 Bug Resolved Normal Use https, not svn to check out the ptll repository David Welker 08/04/2011 02:01 PM
3152 Bug New Normal Use EcoGridServicesController with EcoGridWriter actor ben leinfelder 04/03/2009 02:18 PM
5609 Bug Resolved Normal use different port for HSQL db in .kepler Daniel Crawl 06/11/2012 11:25 AM
4172 Bug Resolved Normal Use DEV server for registry in the WRP suite ben leinfelder 06/19/2009 12:15 PM
2035 Bug Resolved Normal use checkboxes and radio buttons correctly Laura Downey 04/13/2006 03:56 PM
5433 Bug Resolved Normal use 1024m instead of 512m for reporting suite Derik Barseghian 07/08/2011 03:37 PM
5579 Bug Resolved Normal Upload to Repository on actors doesn't work Derik Barseghian 06/15/2012 11:41 AM
2471 Bug Resolved Normal 'Upload to Repository' menu throws an error Chad Berkley 07/07/2006 03:46 PM
5196 Bug Resolved Normal uploading to remote server error. Derik Barseghian 09/30/2010 09:24 AM
5170 Bug New Normal uploading a workflow requires a refresh Derik Barseghian 08/17/2015 08:56 AM
4828 Bug Resolved Normal Uploading a top-level workflow to the repository fails Sean Riddle 02/26/2010 02:29 PM
5312 Bug Resolved Normal updating windowsXP installed 2.0.0 straight to 2.2.0 renders Kepler unable to start David Welker 02/22/2011 01:23 PM
4755 Bug Resolved Normal update workflow run manager and reporting to display runs of sensor workflows Derik Barseghian 02/14/2011 01:45 PM
5490 Bug Resolved Normal update splash screen version without changing image Matt Jones 08/17/2015 09:20 AM
4353 Bug Resolved Normal Update publishing to allow for patches. David Welker 01/07/2010 07:18 PM
4864 Bug Resolved Normal Update paths in demo workflows Chad Berkley 03/16/2010 12:52 PM
4754 Bug Resolved Normal update metacat workflow execution scheduler Jing Tao 02/14/2011 01:45 PM
1606 Bug Resolved Normal Update Kepler to work with Version 4.0 of Ptolemy Chad Berkley 07/19/2004 01:22 PM
5202 Bug In Progress Normal update existing site layout with span changes Derik Barseghian 08/30/2012 05:34 PM
1635 Bug Resolved Normal Update ant build so that documentation appears for new actors Dan Higgins 01/20/2005 10:12 AM
4944 Bug Resolved Normal Unsaved report warning happens once per window Derik Barseghian 04/26/2010 05:26 PM
6681 Bug Resolved Normal unnecessary warnings when removing parameters 03/04/2015 10:34 AM
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3093 Bug Resolved Normal Unit test org.nddp.TestCollectionlOPort does not compile Timothy McPhillips 01/23/2008 04:55 PM
5024 Bug Resolved Normal Uninstaller couldn't delete the rc3 folder on windows 7 Chad Berkley 06/16/2010 09:22 AM
1843 Bug Resolved Normal unexpected workflow components tree behavior Matthew Brooke 02/16/2006 12:51 PM
4355 Bug Resolved Normal unexpected workflow appears in provenance after WRM run deletion Derik Barseghian 09/01/2009 01:50 PM
3901 Bug Resolved Normal unescaped & in <entity name="a & b"> on line 4 Chad Berkley 03/18/2009 01:51 PM
5452 Bug Resolved Normal uneasy access to the demo workflows Daniel Crawl 07/31/2012 12:43 PM
4629 Bug Resolved Normal Undo doesn't roll LSID revision Aaron Aaron 01/24/2010 04:18 PM
4022 Bug Resolved Normal undesired file:\ prefix added by FileParameter Derik Barseghian 08/04/2009 12:31 AM
3785 Bug New Normal Unclear Java requirements for Kepler installer on Vista 64-bit Chad Berkley 04/22/2009 03:39 PM
2315 Bug Resolved Normal Unable to run multiple Kepler instances simultaneously ben leinfelder 04/27/2009 10:19 AM
3056 Bug Resolved Normal unable to print output of Display actor Christopher Brooks 03/21/2008 04:20 PM
4129 Bug Resolved Normal "unable to parse the metadata: null" with dataset judithk.306.21 ben leinfelder 08/12/2009 10:54 AM
5754 Bug Closed Normal unable to open TestSSHWithDisplay 2.3 run-kar from keplerRepository with WRM trunk Derik Barseghian 11/30/2012 02:06 PM
5232 Bug Resolved Normal unable to open KARs saved beneath absent (e.g. third party) modules David Welker 01/28/2011 06:28 PM
5500 Bug Resolved Normal unable to open kar in relaxed mode saved in patched 2.2.0 in 2.3.0 Derik Barseghian 09/30/2011 10:03 PM
5283 Bug Resolved Normal Ul for saving workflows as xml is confusing Daniel Crawl 06/28/2012 04:25 PM
4202 Bug Resolved Normal typos in modules.txt are ignored David Welker 01/07/2010 07:21 PM
3257 Bug Resolved Normal Typos in html docs and demos. Aaron Aaron 04/30/2008 02:21 PM
3985 Bug Resolved Normal Types resolved to unacceptable types ben leinfelder 08/12/2009 12:39 PM
5420 Bug Resolved Normal Two types of NPE issues when 2.2.0 installed and run by a non-admin windows user David Welker 06/13/2011 12:57 PM
5266 Bug Resolved Normal Two empty boxes inside Sinewave actor and other icon problems for attributes Christopher Brooks 12/07/2012 10:39 AM
2419 Bug Resolved Normal turn Digir source 'off' as default data source Jing Tao 04/27/2006 10:19 AM
5274 Bug Resolved Normal Trying to schedule workflow with report layout puts up prompt about no report layout Jing Tao 02/14/2011 01:45 PM
4884 Bug Resolved Normal Trying to log into IPCC anonymously causes Kepler to freeze, and require a force quit. Chad Berkley 03/17/2010 10:59 AM
4398 Bug Resolved Normal Truncated Names of Dynamic ltems debi staggs 09/22/2009 03:34 PM
3542 Bug Resolved Normal Tree View menu is too wide when opened Derik Barseghian 04/03/2009 03:06 PM
4757 Bug Resolved Normal transfer sensor data from dataturbine to metacat manish manish 02/17/2011 12:00 PM
2247 Bug In Progress Normal TRACKING: Popup Dialog Changes Matthew Brooke 04/03/2009 02:18 PM
2270 Bug In Progress Normal TRACKING: Localization and Improvement of User-Visible Messaging Strings Matthew Brooke 04/03/2009 02:18 PM
2417 Bug Resolved Normal TRACKING: DOCUMENTATION - complete first draft of documentation llkay Altintas 08/31/2006 05:38 AM
5681 Bug Resolved Normal Tracking bug for sensor-view-0.9.0 release testing Derik Barseghian 08/30/2012 09:37 PM
5201 Bug Resolved Normal track changes on span server Daniel Crawl 02/14/2011 01:45 PM
3632 Bug Resolved Normal TPC exceedence notification feature ben leinfelder 06/24/2009 10:19 AM
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2396 Bug Resolved Normal TOOLTIPS: Sometimes line/relation tooltip appears when hovering over port Matthew Brooke 12/11/2007 09:53 AM
2397 Bug New Normal TOOLTIPS: dual screen setup - tooltip sometimes shown on wrong screen Matthew Brooke 04/03/2009 02:18 PM
1844 Bug Resolved Normal tool tip problems Matthew Brooke 04/06/2006 05:52 PM
5422 Bug Resolved Normal Tools=>Tag Manager... menu option is missing Sean Riddle 06/14/2011 06:48 PM
5231 Bug Resolved Normal Tools => Preferences menu item gives error on trunk Derik Barseghian 10/28/2010 01:15 PM
2246 Bug In Progress Normal TOOLBAR: status on opening workflows and blank frames Christopher Brooks 04/03/2009 02:18 PM
2355 Bug Resolved Normal TOOLBAR: icon states don't display correctly for first four toolbar buttons Matthew Brooke 04/11/2006 02:43 PM
5155 Bug New Normal To exclude a file or directory requires updating at least four places, only one should be necessary Chad Berkley 08/18/2010 03:54 PM
4696 Bug Resolved Normal Title bar doesn't refresh after rename during Save Archive Derik Barseghian 02/04/2010 01:59 PM
5602 Bug Resolved Normal Timezone confusion using the scheduler Jing Tao 08/14/2012 06:33 PM
5319 Bug Resolved Normal The workflow which archive sensor data into metacat can upload incorrect data set when new datais | Jing Tao 03/22/2011 04:30 PM
coming
5303 Bug Resolved Normal The workflow which archive sensor data into metacat can upload data even no new data was Jing Tao 03/22/2011 04:33 PM
generated
5679 Bug In Progress Normal the workflows in sensor-view should be resaved beneath sensor-view-0.9.0 so users aren't prompted to | Derik Barseghian 08/30/2012 05:34 PM
force open them
3489 Bug Resolved Normal The result of last iteration of composite distributed execution doesn't display. Chad Berkley 09/21/2008 05:05 PM
3117 Bug Resolved Normal The refresh button function in source window was messed up by a KeplerSlaveNode entry in the Jing Tao 01/31/2008 06:09 PM
registry
4877 Bug Resolved Normal The provenance recorder and tagging buttons on the toolbar need tooltips Sean Riddle 03/12/2010 03:20 PM
5674 Bug New Normal The patch downloader dialog can fail to automatically restart Kepler Derik Barseghian 08/16/2012 03:10 PM
4291 Bug New Normal The main menu bar should not change based on the location of focus. Chad Berkley 08/26/2009 03:06 PM
5236 Bug Resolved Normal The list on the left panel of the scheduler should only show WF objects that can be scheduled. Jing Tao 02/14/2011 01:45 PM
5067 Bug New Normal The introduction of basic services so that module names are not referenced. David Welker 07/07/2010 10:22 AM
4989 Bug Resolved Normal The installer should offer to start Kepler Chad Berkley 03/19/2013 03:50 PM
4298 Bug New Normal The GUI should sensibly support internalization. Chad Berkley 08/26/2009 02:53 PM
4038 Bug Resolved Normal The first time ant change-to is run, it prints a stack trace David Welker 05/19/2009 07:54 AM
5023 Bug Resolved Normal The desktop icon of rc3 is a blank page on windows vista Chad Berkley 05/20/2010 02:20 PM
5069 Bug New Normal The ability to create user manuals from a wiki that is continuously updated. David Welker 07/22/2010 10:52 AM
4903 Bug Resolved Normal Text in attributes not rendered properly Sean Riddle 11/29/2012 07:30 PM
4910 Bug Resolved Normal Test module installation system debi staggs 05/13/2010 01:40 PM
4016 Bug Resolved Normal Test IZPack Installer on 64 bit machine Chad Berkley 07/13/2009 02:00 PM
4458 Bug New Normal test for moving kepler directory Derik Barseghian 02/11/2010 04:33 PM
3198 Bug Resolved Normal test dynamic library installations on all platforms Chad Berkley 04/25/2008 11:02 AM
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1359 Bug Resolved Normal Test bug for the SDM Users group, please ignore Matt Jones 03/04/2004 08:44 AM
4663 Bug Resolved Normal Tag shows up in workflow moml when it shouldn't Sean Riddle 03/30/2010 06:13 PM
5215 Bug Resolved Normal tags from a new ontology created within Tag Manager don't show up in Tagging drop-down Sean Riddle 10/27/2010 10:44 AM
4453 Bug Resolved Normal tags don't show up in snow leopard (10.6) Sean Riddle 01/05/2010 10:05 AM
4958 Bug Resolved Normal Tags colors are all white by default under Windows XP with Java 1.5 Sean Riddle 04/27/2010 02:00 PM
4957 Bug Resolved Normal Tags are not visible under Java 1.6 Sean Riddle 04/30/2010 01:46 PM
4919 Bug New Normal tag removal sends two tagRemoved events through provenance Sean Riddle 04/12/2010 01:31 PM
4476 Bug Resolved Normal Tagging / Workflow Run Manager interaction problems Sean Riddle 11/02/2009 01:32 PM
4924 Bug Resolved Normal Tagging a run when provenance is off gives errors Derik Barseghian 04/15/2010 01:11 PM
4980 Bug Resolved Normal Tagging a run now creates two identical tags in the GUI Sean Riddle 05/06/2010 12:10 PM
4185 Bug Resolved Normal TabManager acting strangely Chad Berkley 06/26/2009 10:53 AM
3669 Bug Resolved Normal Tabbed pane interface for holding workflow canvas and additional GUI elements Timothy McPhillips 04/03/2009 03:13 PM
6833 Feature Resolved Normal syntax highlighting for language actors Daniel Crawl 09/11/2015 11:11 AM
4401 Bug Resolved Normal Synchronize properties with selected report item debi staggs 10/19/2009 10:34 AM
4041 Bug New Normal synchronization in matlab actor Daniel Crawl 04/30/2009 10:28 AM
5646 Bug New Normal Switching some of the add-on modules to core llkay Altintas 08/17/2015 08:44 AM
2324 Bug In Progress Normal SVG - old-style icon still displayed for certain actors Matthew Brooke 04/03/2009 01:59 PM
2322 Bug Resolved Normal SVG - Assigning Icons to the Correct Actors in Properties Files Laura Downey 02/17/2006 04:31 PM
2376 Bug Resolved Normal Survey actors for those that need to handle 'nil' values Dan Higgins 12/10/2007 01:44 PM
4706 Bug New Normal support provenance in master-slave 2.0 jianwu jianwu 06/18/2010 10:45 AM
3636 Bug Resolved Normal Support multiple Report formats ben leinfelder 05/19/2009 11:19 AM
1997 Bug New Normal Support Getting Metadata for Darwin Core search result item Jing Tao 04/03/2009 02:18 PM
3568 Bug New Normal support for writing COMAD-style trace files from the Provenance Recorder Timothy McPhillips 04/03/2009 02:50 PM
4003 Bug New Normal Support for non-GUI Kepler installer. jianwu jianwu 05/09/2010 05:12 PM
3573 Bug New Normal Support for importing file contents automatically using CollectionSource Timothy McPhillips 04/03/2009 02:51 PM
3574 Bug New Normal Support for importing directory contents using CollectionSource Timothy McPhillips 04/03/2009 03:18 PM
3714 Bug Resolved Normal Support for environment variable in Kepler. Chad Berkley 12/23/2008 05:40 PM
3576 Bug New Normal support for accessing cascading metadata from within CompositeCoactor Timothy McPhillips 04/03/2009 03:18 PM
2329 Bug Resolved Normal Summary Statistics Actor not working Chad Berkley 01/20/2006 12:37 PM
4503 Bug Resolved Normal Suggest Similar Components gives an error Shawn Bowers 02/04/2010 02:25 PM
4548 Bug Resolved Normal string tokens with newlines print the escape sequences debi staggs 02/09/2011 04:14 PM
4545 Bug Resolved Normal String To Image Converter seems broken Chad Berkley 11/13/2009 03:04 PM
4549 Bug In Progress Normal String Replace actor "remembers" previous execution values ben leinfelder 01/14/2010 10:08 AM
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3896 Bug Resolved Normal String Parameter does not offer option to configure unlike 1.0 release. Chad Berkley 04/22/2009 03:46 PM
5612 Bug New Normal String index out of range in R actor Derik Barseghian 06/01/2012 10:52 AM
2896 Bug Resolved Normal StringConstant actor will not accept strings with '$' Dan Higgins 07/30/2007 11:37 AM
6481 Bug New Normal strange issue with MultipleTabDisplay actor and with Display like actors in general (missing output port 03/27/2014 02:39 AM

in non-gui mode)

5223 Bug Resolved Normal Store the last timestamp of data store for a sensor to the local database manish manish 02/17/2011 11:59 AM
3558 Bug New Normal Store each workflow run trace in it's own directory Timothy McPhillips 04/03/2009 02:50 PM
5222 Bug Resolved Normal Store data set file and associated EML file into metacat manish manish 02/17/2011 11:59 AM
4783 Bug New Normal Standardize workflow parsing to get parameters jilanwu jianwu 02/09/2010 03:56 PM
5485 Bug Resolved Normal standalone Module Manager can break Kepler app ability to startup Derik Barseghian 11/06/2012 05:45 PM
2448 Bug Resolved Normal Splash screen sometimes appears as simple white box Chad Berkley 04/03/2009 02:01 PM
5440 Bug Resolved Normal special checkout behavior for hardcoded ptolemy module names jilanwu jianwu 08/06/2012 12:07 PM
5253 Bug Resolved Normal SpanToDT timestamp bug Daniel Crawl 04/12/2011 03:02 PM
5335 Bug Resolved Normal SpanToDT should write metadata first rather than data when it starts up Daniel Crawl 03/04/2011 10:18 AM
5363 Bug New Normal spanTodt performance Derik Barseghian 08/30/2012 05:34 PM
5359 Bug Resolved Normal SpanToDT NoClassDefFoundError Derik Barseghian 03/30/2011 10:36 AM
5379 Bug Resolved Normal SPAN - add writing metadata changes to pending files Daniel Crawl 04/18/2011 02:03 PM
3215 Bug Resolved Normal Spaces in KEPLER path causes build problems Chad Berkley 04/11/2008 11:16 AM
2513 Bug Resolved Normal Some actors not included in 'ant generateDoc' target Chad Berkley 05/18/2007 11:41 AM
3705 Bug New Normal some actor icons don't denote that they are a composite Derik Barseghian 04/03/2009 03:26 PM
4760 Bug Resolved Normal software to transfer sensor data from SPAN to DT Daniel Crawl 02/14/2011 01:45 PM
5592 Bug Resolved Normal Site Layout DE Director missing documentation Derik Barseghian 06/13/2012 07:08 PM
2277 Bug Resolved Normal Simplify Kar loading Kevin Ruland 02/13/2006 02:19 PM
2265 Bug New Normal Simple Kepler features movie to be displayed at the 1st time installation llkay Altintas 04/03/2009 02:18 PM
2255 Bug Resolved Normal Simple Composite Actor cannot be dragged onto display Chad Berkley 12/09/2005 10:52 AM
3363 Bug Resolved Normal Show name checkbox does nothing for most Parameters Christopher Brooks 04/25/2009 12:25 PM
3694 Bug In Progress Normal Sharing installation among users fails, users must have write permission Jing Tao 03/25/2010 03:39 PM
5284 Bug New Normal Set uploadToServer to be true at configuration.xml Derik Barseghian 01/28/2011 02:18 PM
5208 Bug Resolved Normal Setting sensor sampling rate <1 causes errors Daniel Crawl 02/14/2011 01:45 PM
4446 Bug Resolved Normal serialized workflowRuns should have use a date standard Derik Barseghian 10/12/2009 01:11 PM
5315 Bug Resolved Normal Sensor Site view Components only filtered when All Ontologies and Folders selected Derik Barseghian 03/29/2011 03:22 PM
5205 Bug Resolved Normal Sensor site components not yet in tree Daniel Crawl 02/14/2011 01:45 PM
5583 Bug New Normal Sensor Simulator controllable through Kepler Derik Barseghian 08/30/2012 06:03 PM
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5321 Bug Resolved Normal sensor settings made by kepler user lost on SPAN restart Daniel Crawl 04/18/2011 03:40 PM
5207 Bug Resolved Normal Sensor changes color in response to configuring the actor even if no changes made Daniel Crawl 02/14/2011 01:45 PM
4390 Bug Resolved Normal Semantic Type tag deletion does not remove component from Ontology in the component library Sean Riddle 10/12/2009 03:33 PM
4321 Bug Resolved Normal Semantic types on workflows saved into library not searchable Aaron Aaron 10/15/2009 12:14 PM
5136 Bug Resolved Normal semantic type checker always returns error Sean Riddle 12/09/2010 09:24 AM
4504 Bug Resolved Normal Semantic Type Browser Sean Riddle 10/28/2009 11:07 AM
3135 Bug Resolved Normal semantic type and class params need special handling in doc window Chad Berkley 03/18/2008 03:10 PM
4605 Bug Resolved Normal Semantic Annotation NPE Aaron Aaron 12/14/2009 03:59 PM
4766 Bug Resolved Normal Semantic Annotation Editor doesn't close when you click the close button on mac Derik Barseghian 02/11/2010 07:13 PM
4765 Bug Resolved Normal semantic annotation doesn't appear until you click on workflow Sean Riddle 04/21/2010 03:16 PM
4697 Bug Resolved Normal Semantic Annotation does not increment LSID revision Derik Barseghian 02/09/2010 02:01 PM
5051 Bug Resolved Normal Semantically annotate during Save Archive a workflow with remote data set Error Chad Berkley 07/07/2010 10:45 AM
5269 Bug New Normal Selectordialog and Case actors do not work well together David Welker 01/07/2011 05:07 AM
5169 Bug Resolved Normal select more than one remote repository Daniel Crawl 02/16/2011 04:50 PM
4596 Bug Resolved Normal selecting text entry box of report item moves activation highlight but does not update properties window | debi staggs 12/14/2009 07:29 PM
4997 Bug Resolved Normal SEEK/garpModel_Imaged.xml has an exception while opening David Welker 06/09/2010 01:38 PM
5670 Bug New Normal see if runtimemonitor module can be deleted, contains duplicate code Derik Barseghian 08/10/2012 12:01 PM
5424 Bug Resolved Normal see if it's worthwhile to upgrade hsqgl from 1.8 Daniel Crawl 02/05/2015 10:16 AM
5630 Bug New Normal See about removing one set of ColorTableCellEditor and ColorTableCellRender classes Derik Barseghian 06/18/2012 03:45 PM
3072 Bug Resolved Normal Security issues with distributed execution jianwu jianwu 05/20/2010 09:20 PM
4865 Bug Resolved Normal Second time running a workflow by command line faild Aaron Aaron 03/03/2010 01:13 PM
2239 Bug Resolved Normal Second copy of datasource fails on reload of workflow Jing Tao 03/01/2006 11:22 AM
1837 Bug Resolved Normal Second and thrid searches return same resultset for DarwinCore DataSource Rod Spears 12/17/2004 05:25 AM
1553 Bug Resolved Normal Search Scope for dataset panel Jing Tao 01/20/2005 09:48 AM
3278 Bug New Normal Search result count is inflated when using both KNB sources ([un]authenticated) ben leinfelder 04/03/2009 02:18 PM
1834 Bug Resolved Normal search progress bar does not work on OSX Jing Tao 03/01/2005 10:37 AM
2458 Bug Resolved Normal Search problems with multiple actor ontologies Shawn Bowers 12/11/2007 10:00 AM
4857 Bug Resolved Normal Search on ecogrid server does not return proper results Jing Tao 03/01/2010 11:57 AM
4654 Bug Resolved Normal searching KNB through Kepler returns many console errors and caching fails Jing Tao 01/08/2010 01:47 PM
4346 Bug Resolved Normal Searching for Saved Archive (KAR) workflow in default workflow folder gives error Aaron Aaron 10/02/2009 05:17 PM
4870 Bug New Normal searching for packages with the same name from multiple sources sometimes loses results Chad Berkley 03/04/2010 02:23 PM
4805 Bug Resolved Normal searching for data gives an NPE Jing Tao 02/18/2010 11:44 AM
4758 Bug New Normal search for site components in kepler's data tab Jing Tao 03/26/2012 01:22 PM
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2426 Bug Resolved Normal Search for 'image' in actor tree 'hangs' window in nightly build Dan Higgins 12/10/2007 01:54 PM
1918 Bug New Normal Search based on the semantic annotation of an actor's port Shawn Bowers 04/03/2009 02:18 PM
1920 Bug New Normal Search based on semantic annotations of a dataset's attributes Shawn Bowers 04/03/2009 02:18 PM
3237 Bug Resolved Normal Search actor in remote repository doesn't work Jing Tao 04/24/2008 11:50 AM
5656 Bug Resolved Normal sdm spa StringConst is a duplicate of a Ptolemy actor Derik Barseghian 09/17/2012 06:27 PM
5655 Bug Resolved Normal sdm spa Repeat is a duplicate of a Ptolemy actor jilanwu jianwu 09/20/2012 10:39 AM
5677 Bug Resolved Normal SDF lterations now defaults to AUTO jilanwu jianwu 11/14/2012 03:42 PM
5546 Bug Resolved Normal SDF director iterations parameter default of 0 is unfriendly Christopher Brooks 08/15/2012 07:15 AM
4519 Bug New Normal SDF Director cannot schedule when composite actor input port is disconnected Chad Berkley 01/13/2010 02:18 PM
2369 Bug Resolved Normal Scrollbars Disappear After Using Fullscreen Mode--Now crashes Christopher Brooks 06/12/2012 08:23 AM
5235 Bug Resolved Normal Scheduler GUI can schedule any wf (even local ones). Jing Tao 02/23/2011 04:55 PM
5760 Bug In Progress Normal saving xml to existing file asks twice on mac Daniel Crawl 12/19/2012 11:18 AM
5230 Bug Resolved Normal saving workflow that has instances of user created class to a KAR gives errors Chad Berkley 10/29/2010 10:23 AM
4450 Bug Resolved Normal Saving workflow in Windows 7 Chad Berkley 10/16/2009 03:26 PM
5727 Bug Resolved Normal saving workflow changes canvas center Daniel Crawl 01/16/2013 07:26 PM
2440 Bug Resolved Normal Saving Workflow Matthew Brooke 04/12/2007 02:50 PM
5412 Bug Resolved Normal saving with an open plot window crashes David Welker 06/10/2011 12:42 PM
2978 Bug Resolved Normal saving to actor library from kepler no longer consistently works and port information is lost Dan Higgins 01/18/2008 11:21 AM
5323 Bug Resolved Normal saving Site Layout workflow makes Sensor actor parameters editable Daniel Crawl 03/03/2011 03:10 PM
6831 Bug Closed Normal saving/loading window properties for multiple graphs/models in BasicGraphFrame Christopher Brooks 08/17/2015 01:14 PM
2330 Bug Resolved Normal Saving a workflow doesn't add .xml or .moml extenders Chad Berkley 02/13/2006 03:27 PM
3222 Bug New Normal save new workflow template Matthew Brooke 04/03/2009 02:18 PM
2884 Bug Resolved Normal 'Save in Library' not persistent (or repeatable) Dan Higgins 07/11/2007 10:00 AM
3038 Bug New Normal Save in Library Dialog problem with default Category Shawn Bowers 04/03/2009 02:18 PM
3220 Bug New Normal "Save" from TextEditor interferes with workflow save-before-closing prompt ben leinfelder 09/03/2009 04:20 PM
4525 Bug Resolved Normal saved KAR and memory report can be out of sync ben leinfelder 11/18/2009 02:25 PM
5725 Bug Resolved Normal Save dialog's folder drop-down menu crashes kepler in OS X 10.8 w/ 64-bit java Derik Barseghian 03/14/2013 10:09 AM

1.6.0_37-b06-434-11M3909

5380 Bug Resolved Normal Save As no longer disposes old window Aaron Aaron 04/26/2011 05:00 PM
3531 Bug New Normal Save As dialog inconsistent between linux and mac Derik Barseghian 04/03/2009 02:45 PM
5153 Bug New Normal Save As... closes all windows associated with a workflow Derik Barseghian 08/23/2015 02:26 PM
4973 Bug Resolved Normal Save Archive sometimes saves more or less than it should in WRP Derik Barseghian 05/17/2010 01:56 PM
4546 Bug Resolved Normal Save Archive on an actor quits Kepler ben leinfelder 11/18/2009 10:05 AM
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5098 Bug Resolved Normal Save Archive (KAR)... will have exception when internet is not accessible. Chad Berkley 04/11/2011 09:54 PM
4916 Bug Resolved Normal Save Archive gives an error Aaron Aaron 04/05/2010 05:03 PM
5184 Bug Resolved Normal sanity check(s) when attempting to open owl file Sean Riddle 09/29/2010 01:21 PM
3092 Bug Resolved Normal sampling_occurrenceData_ R.xml demo workflow Chad Berkley 01/23/2008 10:03 AM
5381 Bug Resolved Normal run-workflow does not work for KAR files David Welker 06/11/2012 11:50 AM
5632 Bug New Normal Runtimemonitor token count idicator placement needs improvement Derik Barseghian 06/22/2012 01:41 PM
4888 Bug Resolved Normal Runs with 1 error don't highlight red in WRM Aaron Aaron 03/18/2010 04:21 PM
4293 Bug New Normal Run, Pause, and Stop should be in the menu, not just the toolbar. Chad Berkley 08/26/2009 02:53 PM
4712 Bug Resolved Normal Running Kepler from IntelliJ IDEA does not work David Welker 01/31/2010 09:28 PM
3902 Bug Resolved Normal Running Kepler from Eclipse...No actors on right pane Chad Berkley 04/06/2009 12:07 PM
5449 Bug Resolved Normal Running ant should include instructions about updating kepler-tasks.jar David Welker 06/17/2012 04:51 PM
5434 Bug Resolved Normal run-kar result from headless kepler.sh execution doesn't contain report artifacts Derik Barseghian 06/30/2011 03:19 PM
4749 Bug New Normal run google earth within kepler gui Daniel Crawl 03/28/2011 05:11 PM
4634 Bug Resolved Normal run archive causes NPE when building local repository Derik Barseghian 01/28/2010 10:50 AM
5019 Bug Resolved Normal R_output_example.xml fails Chad Berkley 05/20/2010 11:32 AM
4593 Bug Resolved Normal ROML lost when saving workflow with a composite actor to KAR after saving XML after saving to KAR | debi staggs 12/01/2009 02:16 PM
4592 Bug Resolved Normal ROML lost when saving KAR a second time debi staggs 12/01/2009 09:25 PM
4572 Bug Resolved Normal ROML lost when reported ports are in composite actors debi staggs 11/23/2009 10:08 AM
4979 Bug Resolved Normal ROML has type of Reportinstance instead of ReportLayout in kar manifest Derik Barseghian 05/05/2010 12:22 PM
4662 Bug Resolved Normal roll revision vs. new object ID ben leinfelder 02/10/2010 10:12 AM
4981 Bug In Progress Normal RIO pdfs don't show up in the Component Library Derik Barseghian 02/04/2011 03:26 PM
4051 Bug Resolved Normal R - include R distribution in separate module Chad Berkley 05/18/2009 11:07 AM
4810 Bug New Normal [right click]->Save Archive (KAR) on composite actor borks port attributes Chad Berkley 02/18/2010 01:40 PM
4614 Bug Resolved Normal right click -> Open on an existing run adds an entry to the wrm Derik Barseghian 01/13/2010 11:49 AM
4885 Bug Resolved Normal Right-clicking on KARs in the component pane produces exception Aaron Aaron 03/23/2010 12:46 PM
4914 Bug Resolved Normal right-clicking on any item in Outline view gives exceptions Aaron Aaron 03/30/2010 01:32 PM
2803 Bug Resolved Normal Right click documentation menu item from left pane Chad Berkley 06/05/2007 02:29 PM
3184 Bug Resolved Normal right-click context menu in RExpression actor ben leinfelder 04/06/2009 09:46 AM
4736 Bug New Normal RFE speed up Suggest Similar Components feature Derik Barseghian 02/04/2010 02:28 PM
4276 Bug Resolved Normal RExpression temp files can collide ben leinfelder 10/21/2009 08:55 AM
2375 Bug Resolved Normal RExpression support for nil tokens Dan Higgins 03/27/2006 09:55 AM
4879 Bug New Normal RExpression replaces ) in string vectors with } when outputting to a port ben leinfelder 03/12/2010 10:37 AM
4876 Bug New Normal RExpression - recursively handle arrays ben leinfelder 03/11/2010 03:25 PM
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4407 Bug New Normal RExpression problems with named non-numeric vectors ben leinfelder 01/13/2010 02:34 PM
4881 Bug New Normal RExpression outputs [false] for any matrix of booleans ben leinfelder 03/12/2010 10:53 AM
4268 Bug New Normal RExpression output ports search entire search path for objects to export Chad Berkley 08/12/2009 03:25 PM
4318 Bug Resolved Normal RExpression NA converts to string "nil", not value nil Chad Berkley 08/17/2009 08:15 AM
3910 Bug Resolved Normal RExpression multiport input drops record columns ben leinfelder 04/14/2009 10:00 AM
3332 Bug Resolved Normal RExpression_Matrix_IO_Test workflow gives an error ben leinfelder 04/29/2009 05:16 PM
3349 Bug Resolved Normal RExpression getUniqueFileName functionality is broken Derik Barseghian 05/30/2008 01:34 PM
5590 Bug New Normal RExpression forces pdf if ‘automatically show graphics' is checked ben leinfelder 08/21/2015 04:16 PM
3909 Bug Resolved Normal RExpression fails with certain port names ben leinfelder 04/02/2009 10:32 AM
4271 Bug Resolved Normal RExpression fails when options(echo = FALSE) is set ben leinfelder 07/29/2009 06:47 AM
4710 Bug Resolved Normal RExpression fails to convert arrayType(niltype) ben leinfelder 02/10/2010 10:02 AM
4270 Bug Resolved Normal RExpression exports special characters in strings as the 2 character escaped sequence ben leinfelder 07/30/2009 09:37 AM
4827 Bug New Normal RExpression does not handle matrix tokens correctly. Chad Berkley 06/24/2011 02:40 PM
4267 Bug Resolved Normal RExpression converts nil input into "NA" ben leinfelder 07/28/2009 12:27 PM
3986 Bug Resolved Normal RExpression confounding R working directory and .kepler folder ben leinfelder 04/28/2009 12:01 PM
4880 Bug New Normal RExpression cannot output matrix of strings ben leinfelder 03/12/2010 10:54 AM
4272 Bug Resolved Normal RExpression cannot handle irregular Record tokens Chad Berkley 07/29/2009 07:34 AM
4795 Bug New Normal RExpression & cache cleaning Chad Berkley 02/12/2010 05:29 PM
3443 Bug Resolved Normal Rexpression actor, relation vs multiport and port type resolution Derik Barseghian 07/09/2008 05:35 PM
2958 Bug Resolved Normal RExpression actor problem with large string arrays Dan Higgins 10/30/2007 12:02 PM
3213 Bug Resolved Normal R expression actor introduces leading/trailing whitespace ben leinfelder 04/08/2008 10:31 AM
3912 Bug Resolved Normal RExpression actor has a single line text entry field Chad Berkley 03/26/2009 09:23 AM
3324 Bug Resolved Normal RExpression actor doesn't output properly with >1 dataframe output port Derik Barseghian 05/29/2008 03:56 PM
3187 Bug In Progress Normal RExpression actor does not share focus ben leinfelder 04/03/2009 02:18 PM
3451 Bug Resolved Normal RExpression actor can get typing wrong for incoming numeric vector /array on first workflow run Derik Barseghian 07/14/2008 02:48 PM
4010 Bug New Normal RExpression2 - tracking for backwards compatibility ben leinfelder 02/23/2010 12:58 PM
3962 Bug Resolved Normal RExpression2 - support RecordTokens with length=1 ben leinfelder 04/13/2009 03:13 PM
3963 Bug Resolved Normal RExpression2 - support mixed lists output from R ben leinfelder 04/14/2009 09:07 AM
3961 Bug Resolved Normal RExpression2 - support arrayType(scalar, ....) tokens ben leinfelder 04/13/2009 10:35 AM
3960 Bug Resolved Normal RExpression2 - support arrayType(array Type(....)) tokens ben leinfelder 04/13/2009 04:29 PM
4002 Bug New Normal RExpression2 - handle arbitrary R data structures ben leinfelder 08/18/2009 03:18 PM
5030 Bug New Normal RExpression2 actor will fail if the libs are not found ben leinfelder 05/27/2010 02:14 PM
2348 Bug In Progress Normal Rewrite disk based GIS code for speed increase Dan Higgins 04/03/2009 02:18 PM
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4803 Bug Resolved Normal Review the README file Chad Berkley 03/09/2010 04:10 PM
1665 Bug Resolved Normal Review ENM/GARP pipeline so it works with openModeller actor Ricardo Pereira 04/06/2007 01:37 PM
2038 Bug Resolved Normal review and correct information design (e.g., graphical layouts) Matthew Brooke 02/28/2006 08:05 PM
1902 Bug Resolved Normal review all useablity reports for specific bugs not already entered Dan Higgins 01/24/2005 02:55 PM
3183 Bug New Normal Return/Enter does not select default button in dialog boxes Matthew Brooke 04/03/2009 02:18 PM
5216 Bug Resolved Normal Retrieve the timestamps for all the metadata changes that occurred since a previous time manish manish 02/17/2011 12:00 PM
5217 Bug Resolved Normal Retrieve the metadata of a sensor at a specific timestamp manish manish 02/17/2011 12:00 PM
5214 Bug Resolved Normal Retrieve the last timestamp for which a sensor's data was stored in metacat manish manish 02/17/2011 12:00 PM
5662 Bug Resolved Normal resurgence ArrayAccumulator is a duplicate of Ptolemy ArrayAccumulate Derik Barseghian 09/17/2012 09:44 PM
5147 Bug Resolved Normal Resolve issue with modules.txt David Welker 08/20/2010 12:08 AM
3407 Bug New Normal reset debugging windows, add timestamps Chad Berkley 04/03/2009 02:18 PM
3807 Bug Resolved Normal reserved symbols in record names passed to the RExpression actor generate a missing R error ben leinfelder 07/28/2009 03:29 PM

message

5008 Bug Resolved Normal Research Copyrights before 2.0.0 release. David Welker 06/16/2010 09:20 AM
3984 Bug Resolved Normal RequireVersion parameter cannot be deleted from a saved workflow Christopher Brooks 04/25/2009 10:07 AM
3952 Bug Resolved Normal Report Viewer - use Provenance Recorder to get Querable ben leinfelder 04/06/2009 04:59 PM
4472 Bug Resolved Normal Report Viewer - use different ViewPane class ben leinfelder 10/20/2009 03:58 PM
4223 Bug Resolved Normal Report Viewer - Text runs over edge of button for 'Refresh using current layout' ben leinfelder 07/06/2009 10:21 PM
4220 Bug Resolved Normal Report Viewer - South label is not being rendered ben leinfelder 07/06/2009 10:42 PM
4508 Bug Resolved Normal report viewer should listen for executions to finish ben leinfelder 10/27/2009 05:05 PM
3953 Bug Resolved Normal Report Viewer - scroll bars ben leinfelder 04/07/2009 09:01 AM
3998 Bug Resolved Normal Report Viewer - render Report Instance on???Event ben leinfelder 06/08/2009 11:34 AM
4471 Bug Resolved Normal Report Viewer - remove TOC ben leinfelder 10/20/2009 03:59 PM
4217 Bug Resolved Normal Report Viewer - "nil" not rendering consistently/correctly ben leinfelder 07/02/2009 10:53 AM
4221 Bug Resolved Normal Report Viewer - Need more space between each element ben leinfelder 07/07/2009 09:05 AM
4468 Bug Resolved Normal Report Viewer - message to run workflow first ben leinfelder 12/15/2009 08:47 AM
4469 Bug Resolved Normal Report Viewer - labels take up too much space ben leinfelder 10/21/2009 09:31 AM
4470 Bug Resolved Normal Report Viewer - labels should be vertically centered ben leinfelder 10/20/2009 05:25 PM
3951 Bug Resolved Normal Report Viewer - improve TOC panel ben leinfelder 08/05/2009 04:04 PM
3941 Bug Resolved Normal Report Viewer - handle Text items ben leinfelder 04/03/2009 03:22 PM
3936 Bug Resolved Normal Report Viewer - handle Image items ben leinfelder 06/15/2009 02:54 PM
3935 Bug Resolved Normal Report Viewer - handle HR items ben leinfelder 04/03/2009 02:16 PM
4474 Bug Resolved Normal Report viewer - enable scroll wheels ben leinfelder 10/20/2009 04:56 PM
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4125 Bug Resolved Normal ReportTest does not compile debi staggs 06/02/2009 04:44 PM
4562 Bug Resolved Normal report seems to exist in MOML workflows when kar of same name exists in a local repository debi staggs 11/22/2009 07:49 PM
5094 Bug Resolved Normal reports do not display matrix or xml token data Derik Barseghian 08/02/2010 10:56 AM
4119 Bug Resolved Normal Report Model - use LSID to link layout to workflow ben leinfelder 06/09/2009 11:59 AM
3995 Bug Resolved Normal Report Model - [de]serialize Report ltem properties ben leinfelder 06/15/2009 01:32 PM
3996 Bug Resolved Normal Report Model - [de]serialize ltems of Interest ben leinfelder 06/22/2009 04:21 PM
4571 Bug Resolved Normal report "lost" from KAR ben leinfelder 12/16/2009 10:40 AM
5017 Bug Resolved Normal ReportLayout LSID and referral list should be maintained Derik Barseghian 02/01/2011 03:06 PM
5090 Bug New Normal Report Layout interface is confusing wrt locking and switching to old layouts Derik Barseghian 07/07/2011 01:30 PM
5100 Bug Resolved Normal Report Layout designed in a composite actor window is lost Derik Barseghian 07/22/2010 06:35 PM
4669 Bug Resolved Normal report layout changes, but text field displays previous content debi staggs 03/24/2010 04:21 PM
4509 Bug Resolved Normal Report instance not being serialized with Save Archive ben leinfelder 10/28/2009 03:30 PM
5086 Bug New Normal Report instance does not show in viewer after kar open Derik Barseghian 07/09/2010 01:15 PM
4938 Bug Resolved Normal Reporting suite no longer works on its own Derik Barseghian 05/11/2010 05:01 PM
5096 Bug Resolved Normal Reporting on a RecordToken fails Derik Barseghian 08/02/2010 10:57 AM
4582 Bug Resolved Normal reporting/module-info/module.properties debi staggs 12/03/2009 10:38 AM
4441 Bug Resolved Normal reporting fails to output figure ben leinfelder 10/21/2009 10:28 AM
4439 Bug Resolved Normal reporting displays output for a different actor Daniel Crawl 01/13/2010 03:46 PM
4959 Bug Resolved Normal Reporting call to getDefaultProvenaceRecorder occasionally gets an NPE Derik Barseghian 04/26/2010 05:08 PM
5409 Bug Resolved Normal reporting 2.1 can not start when setting "JDBC URL" in provenance. Daniel Crawl 06/06/2011 06:18 PM
5061 Bug Resolved Normal Report Design Panel needs fixing wrt event listening Derik Barseghian 01/31/2011 06:05 PM
3639 Bug Resolved Normal Report design features, Stage 3 debi staggs 08/10/2009 03:24 PM
3638 Bug Resolved Normal Report design features, Stage 2 debi staggs 06/29/2009 08:53 AM
3637 Bug Resolved Normal Report Design Features, Stage 1 debi staggs 06/03/2009 03:39 PM
3994 Bug Resolved Normal Report Designer - use "workflow outline" rather than Items of Interest debi staggs 06/22/2009 03:58 PM
4226 Bug Resolved Normal Report Designer - use 16pt bold for Report Title text field debi staggs 07/07/2009 03:03 PM
3955 Bug Resolved Normal Report Designer - static report item: TEXT debi staggs 05/19/2009 11:03 AM
4464 Bug Resolved Normal Report Designer - selection pointer behavior debi staggs 10/19/2009 12:24 PM
4466 Bug Resolved Normal Report Designer - report layout not shown when opening KARs ben leinfelder 10/20/2009 03:33 PM
4237 Bug Resolved Normal Report Designer - Replace the image icon, not the + sign.with the thumbnail of the user selected file. debi staggs 07/26/2009 03:59 AM
3957 Bug Resolved Normal Report Designer - remove items of interest from the list debi staggs 06/23/2009 10:54 AM
4242 Bug Resolved Normal Report Designer - PC issue - Improve the cursors. debi staggs 09/01/2009 11:58 AM
4239 Bug Resolved Normal Report Designer - PC issue - Grey backgrounds. debi staggs 07/26/2009 04:39 AM
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5295 Bug Resolved Normal Report designer panel gui simplification and spacing Derik Barseghian 02/08/2011 04:45 PM
4176 Bug Resolved Normal Report Designer - opening KAR omits title debi staggs 06/30/2009 10:56 AM
4213 Bug Resolved Normal Report Designer - north and south labels swap debi staggs 06/30/2009 03:37 PM
4240 Bug In Progress Normal Report Designer - Menus with Copy, Cut, and Paste as related to Text Fields / Section Headers debi staggs 05/13/2010 03:11 PM
5305 Bug New Normal Report designer - make north and south dynamic item labels left justified Derik Barseghian 02/14/2011 02:21 PM
5304 Bug New Normal Report designer - make "+ Get Image..." button much smaller Derik Barseghian 02/14/2011 02:16 PM
5306 Bug New Normal Report designer - make dynamic report item label textfields smaller Derik Barseghian 02/14/2011 02:24 PM
4195 Bug Resolved Normal Report Designer - 'Location aware' rendering of newly dropped panels. debi staggs 07/27/2009 11:25 AM
3954 Bug Resolved Normal Report Designer - items of interest scrolling debi staggs 04/08/2009 12:45 PM
3956 Bug Resolved Normal Report Designer - item label editing debi staggs 04/07/2009 10:43 AM
4188 Bug Resolved Normal Report Designer - Issues with text fields debi staggs 06/30/2009 04:42 PM
4222 Bug Resolved Normal Report Designer - icon for the static graphic image switches back to generic icon after a drop debi staggs 07/06/2009 10:48 PM
3959 Bug Resolved Normal Report Designer - Highlight and select a report item panel debi staggs 05/19/2009 10:59 AM
5088 Bug Resolved Normal Report designer gui difficult to use with greater than about 3-4 items Derik Barseghian 02/03/2011 05:09 PM
5307 Bug New Normal Report designer - fix drag and drop outline sizes Derik Barseghian 02/14/2011 02:31 PM
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